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OOOvvveeerrrvvviiieeewww   ooofff   ttthhheee   MMMiiicccrrrooosssooofffttt   WWWooorrrddd   IIInnnttteeerrrfffaaaccceee 
Microsoft Word is an application designed primarily for word processing.  You can also use it for mail merge, or to 
create tables. There are some new features in Word 2003 worth exploring, such as research for looking up 
information, a layout reading format to see how your pages look, as well as a new help icon for easy access.  Word 
also has a clip art feature for creating graphics on pages, new tables, and other features that can be used.  Other tips 
that will be included in Intermediate Word include: clip art, document style, tables and lists as well as tracking 
changes.  
 
SSStttaaarrrttt iiinnnggg   WWWooorrrddd   222000000333 
The best way to start learning the new features of Word 2003 is by starting the program. In the graphic below are 
some of the featured highlights that are being indicated for you to look for in your new Word packet.  One of the 
biggest changes in Word 2003 is purely cosmetic - the look of a Word 2003 document is more three-dimensional 
than in previous versions of Word. 
 
Steps to perform will appear in highlighted blue text throughout the handout. Perform these steps in this document, or 
print out this packet and start your own blank document.  
             To start Microsoft Word 2003: 
             1) Go to your Start menu  
             2) Then to Programs and look for Microsoft Office  
             3) A series of Microsoft Programs will appear.  Select Microsoft Word 2003 to start.   
             
NOTE: If you want, you can drag the Microsoft Word icon to your desktop to create a shortcut for easy access. 
                          
             Below are some of the new features, as well as familiar features in the Word 2003. 
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TTTiii ttt llleee   bbbaaarrr       
At the top of the window is a blue bar called the title bar.  The title bar contains the name of the application (Word) 
and the name of the document you are working in (automatically called “Document 1” until you rename it). The title 
bar also includes the minimize, maximize, restore, and close buttons which look like this: .  Below the title 
bar is the menu bar, containing lists of commands used to give Word instructions.   
 
MMMeeennnuuu   bbbaaarrr    ///    TTToooooolllbbbaaarrr    OOOpppttt iiiooonnnsss 
Below the title bar is the menu bar, containing lists of commands you will use with Word. Many of the menus on this 
bar – such as file, edit, format, or help - will seem familiar if you use other Microsoft products. Beneath the menu bar 
is the standard toolbar, which contains buttons with images that correspond to some frequently-used menu 
commands: 
 
 
 
To see what a toolbar button does, pause your mouse pointer over the button and a brief description will appear. Try 
this now. 
Many of the features look familiar such as a new document, save and print.  Some of the new features are:  

  The permission button, which allows unrestricted access and can be used to either allow access 
or prohibit access to a particular document. 

  Another feature is the research button that helps you locate information online while working on 
an assignment. 

  Yet another feature is the read button, which allows you to see the layout of the pages you 
are typing side by side. (This is covered further on page 4.) 

  Lastly there is the help button, which provides for easy access to the help menu in the Task Pane.  
  

SSStttaaatttuuusss   BBBaaarrr    
At the bottom of the screen you will see the status bar, which displays information to keep you informed as to the 
current state of Word. When you first start Word, next to the scroll button you will see five icons . 
Starting from the left to right, the icons are normal view, web layout, print layout, outline view, and the newest is 
reading view. At the bottom of the status bar indicates all the usual features of Word 2000 such as Page number, 
Section and so on.  Choose each of these views now – being sure to return to the normal view  when you are 
finished. 

 
HHHooorrr iiizzzooonnntttaaalll    aaannnddd   VVVeeerrrttt iiicccaaalll    RRRuuullleeerrrsss   
In print layout view, at top of the word document and on the left side are located the rulers.  The horizontal ruler can 

adjust the page margins by pulling either the top or bottom arrow   either right or left to make the margins either 
smaller or larger. Try this now.  

 
OOOffffff iiiccceee   AAAssssssiiissstttaaannnttt    
This interactive graphic is one way to access help in Word, although you can always 
choose Help  Microsoft Word Help (or use F1) for assistance if the graphic is not 
visible.  If the Office Assistant shown in the overview (the paper clip) is visible and you 
want to change it to another Office Assistant, you can right click on the assistant and 
select Choose Assistant, to choose from the various options. (NOTE: If you want to get 
rid of Clippit the Office Assistant, you can go to Help and then Hide the Office Assistant 
Another nifty trick is to use your mouse and right click on the Assistant, click on Hide and your assistant will 
disappear. You can make it reappear by going to Help  Show the Office Assistant. 
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HHHeeelllpppfffuuulll    WWWooorrrddd   KKKeeeyyybbboooaaarrrddd   SSShhhooorrrtttcccuuutttsss   
As in most Microsoft Office products, a number of keyboard shortcuts exist in Word that can save you time:    

CTRL+O    Open    
CTRL+Z    Undo    
CTRL+Y    Redo. In some cases, if there is nothing to 

redo, this repeats the last action.    
CTRL+S    Save    
CTRL+P    Print    
ALT+F4    Close the active window    
CTRL+B    Bold    
CTRL+I    Italic    
CTRL+U    Underline    
CTRL+R    Align right    
CTRL+E    Align center    
CTRL+L    Align left    
CTRL+C    Copy    
CTRL+X    Cut    
CTRL+V    Paste    
CTRL+C+CTRL+C    Open the clipboard    
CTRL+F    Find    
CTRL+H    Replace    
CTRL+A    Select whole document    
F7    Spell checker    
SHIFT+F7    Thesaurus    
CTRL+SHIFT+S    Style box    
CTRL+SHIFT+F    Font    
CTRL+SHIFT+N    Change font to Normal style    

   
   
Try several of these shortcuts now to familiarize yourself with these commands.  
 

HHHeeelllpppfffuuulll    KKKeeeyyybbboooaaarrrddd   NNNaaavvviiigggaaattt iiiooonnn   HHHiiinnntttsss   
 

Keystroke Shortcuts Press SHIFT+ any of the following keystrokes to 
select text 

Left one character at a time LEFT ARROW 
Right one character at a time  RIGHT ARROW 
Down one line at a time DOWN ARROW 
Up one line at a time  UP ARROW 
Left one word at a time  CTRL+ LEFT ARROW  
Right one word at a time  CTRL+ RIGHT ARROW 
To the beginning of the current line of text  HOME  
To the end of the current line of text  END 
To the beginning of the document CTRL+HOME 
To the end of the document CTRL+END 
Up one full screen PAGE UP 
Down one full screen PAGE DOWN 
To the beginning of the previous page CTRL+PAGE UP 
To the beginning of the next page CTRL+PAGE DOWN 
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RRReeeaaadddiiinnnggg   VVViiieeewww   
   

   
 
    
   

When you press the read button (  or ), this layout appears,  allowing you several new functions. Try these out 
now:   

1) The Document Map Icon displays the document map in a panel on the left side of the window.  

2) The Thumbnails Icon displays several pages of the document in a thumbnail format at the left side of the window.  

3) The Research Icon Opens the Research task pane at the right side of the window.  

  4) The Text Size Buttons give you the ability to make the text larger (or smaller) for reading purposes without changing    
the font size.   

5) The Actual Page button allows you to see what the text would look like on a page if you printed it. This is similar to 
print layout view.   

6) The Allow Multiple Pages button let you look at two pages side by side, as you do when you read a book.  

7) The Close icon lets you exit out of the Reading Layout. 

To prevent documents from opening in Reading Layout view: On the Tools menu, click Options, and then on the 
General tab, clear the Allow starting in Reading  Layout check box. .  
    

FFFooonnntttsss   
In order to change fonts in your document, you can click the icon on the tool bar:     

You can also change fonts by selecting text and going to Format  Font.  
The Normal and Arial Icon are types of styles you can create with your Word document.  The second box,  Arial      
Narrow is a type of Font and the 11 is the size of the font selected.  You can change the font size in by pushing down on the 



UM Libraries – Word 2003 Overview 
 

5 

down-arrow button. (You can also go to Format  Font and adjust it there.) 
 
           

   
   
   
 
 

You can also apply  Bold, Italics and Underlining to your text using the keys above on the menu bar which look like this: 
.  To do this -highlight the word or phrase you want in either Bold, Italics or Underline and then click one of the 

buttons above to get the desired effect.   (NOTE: You can also use the Ctrl + B, Ctrl+I, or Ctrl+ U shortcuts.) 
   
   

PPPaaarrraaagggrrraaappphhhsss   
 When creating Paragraphs you will often use several formats in your document.  The three buttons on the menu bar are 

 from left to right: Align Left, Center, Align Right, and Justify.  You can also go to the Format 
Paragraph and select what you would like under General:  Alignment. 

 

              
   
You can also choose Line Spacing of your text on this same menu, making it either single, 1.5 or double spaced. 
 
TTTaaabbbllleeesss   
In order to create a Table, go to the Menu Bar and click on Table.   

                
Then go to Insert and Table.  You will then get a menu like this: 
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Just enter in Table size the number of columns you want and the number of rows to appear. Then click OK. 
 Your table will appear, as seen below:   

   
            1) The cross in the box in the upper left corner allows you to move your table 
            2) The line with the arrow  facing opposite directions allows you to either expand or shrink your tables.  You  
                can then enter the  information just like you would an Excel sheet.    
            3)To move from cell to cell, hit the TAB button.  
Try this now…insert a table with two columns and rows here:  
 
 
                           
CCClll iiippp   AAArrrttt                         

In order to insert Clip Art or graphics in your documents, go to the 
Menu Bar and click on Insert   Picture  Clip Art. 
 
You will then get a menu in the task bar on the right side of your 
screen, and you can type in a term to search for what you’re 

interested in inserting.   A list of 
related clip art graphics will appear. 

 
In order to insert the image in your document, double-click on the image desired and it will appear on your screen, just like 
the “dog chewing on the shoe” cartoon below.   
             
 NOTE: For a larger selection, you can go to http:// www.microsoft.com and go to Clip Art to search for additional images. 
             
 
 
 
   Once you insert an image, a little menu bar will appear on your screen along with your picture that looks 

like this:       
          

 
               
 In order to modify and be able to move your picture, click on the fourth button from the 
right with the little dog and lines behind them (the text wrapping icon).  Choose the option 
Tight which will allow you to move your text and your image more easily.  If you click on 
the image itself, little circles will appear that will allow you either expand or contract your 
image.  If you right click on the image itself, you get this menu and you can click on 
Format Picture and go to Picture where you can change the size and shape of the 
picture.   
 
Try this now. Insert a clip art image in the space below, and resize it as needed to fit on 
this page.  
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BBBuuulll llleeetttsss   aaannnddd   NNNuuummmbbbeeerrr iiinnnggg   
In order to add bullets and numbering to your paragraphs, highlight the text you would like to apply bullets/numbering to and: 
1) Go to Format Bullets and Numbering 
 
 
 
 
 
 
 
 
2) The Bullets and Numbering menu will appear allowing you to choose the types of bullets and numbering system you 
would like. 

  
Once you have selected the style you want, click OK.  

To insert the default bullet or numbering scheme to your text, you can also click the  buttons on the toolbar. 
 
Try this now…by following the directions above, add bullets or numbering by selecting the following text: 
 
To add bullets or numbering to text as you type: 
Type 1. to start a numbered list or * (asterisk) to start a bulleted list, and then press SPACEBAR or TAB. 
Type any text you want.  
Press ENTER to add the next list item. 
Word automatically inserts the next number or bullet. 
To finish the list, press ENTER twice, or press BACKSPACE to delete the last bullet or number in the list. 
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EEEnnnvvveeelllooopppeeesss   aaannnddd   LLLaaabbbeeelllsss   
 
In order to format Envelopes and Labels, you can go to Tools  Letters and Mailing  Envelopes and Labels.   

 
The Envelopes and Labels dialog box will appear..    

 
 
 
 
 

 

                                                                                                                         

 2) Click on Options and this menu will appear: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3) You can select the option of Product number and which label you’ll use such as Avery (i.e. 5161) or whatever is on 
the box of labels you are using by scrolling down the menu. Then click Ok.   
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To try this out, click New Blank Document icon  on the menu bar. 
 

1) Type a mailing address, pressing enter after each line.  
 
2) To print an envelope, go to Tools  Letters and Mailings  Envelopes and Labels 
 
3) In the dialog box that appears, enter the return address in the space provided, or click on the Omit checkbox to 
suppress a return address. 
 

 
 

4) Click on Options to verify or change the envelope size, and click OK. 

  
 
5) Insert your envelope into your printer as directed, and click Print.  



UM Libraries – Word 2003 Overview 
 

10 

TTTiiipppsss   aaannnddd   TTTrrr iiiccckkksss   
 
Take advantage of the context-sensitive menus that appear when you right-click the mouse.  (This same 
trick works throughout Windows applications.) 
 
Are you tired of Microsoft Word second-guessing your every move?  To change AutoCorrect and 
AutoFormat settings, click on Tools  AutoCorrect Options.  Click on the AutoFormat as you Type tab, 
and uncheck the appropriate boxes. Click OK.  (Press Cancel if you decide not to make any changes.) 
 
Automatically make a table of contents for your document….At the top of your document, click on the Insert menu, 
point to Reference, and click Index and Tables. Click the Table of Contents tab. To use one of the available 
designs, click a design in the Formats box. Select any other table of contents options you want.  
 
Did you misspell an important name throughout your entire report?  Eek!  Highlight the incorrect word, and 
go to Edit  Replace.  Type in the correct spelling, then, click on Replace All.  (HINT: Save your 
document before you do this, just in case there are unexpected results.) 
 
Would you like to turn off the annoying green grammar checker?  Click on Tools  Options.  Click on the 
Spelling and Grammar tab. Uncheck the box next to Check grammar as you type. 
      
Do you want to locate a word, number, or phrase within your document? Use Find and Replace. Go to Edit 

 Find (or Ctrl+F), select the Find tab, and enter the text of what you are looking for into the document. 
(Try this now…try looking for the word dog in this document.)  
 
AAAcccccceeessssssiiinnnggg   WWWooorrrddd   HHHeeelllppp   
 
There are a number of ways to access help features within Word. 

• To open the Word Help task pane:  
o Press F1, 

o Click on the Help button  on the Standard 
Toolbar, or  

o Go to the Help menu and select Microsoft 
Word Help.  

 

You can also:  

• Double-click on the Office Assistant. A dialog box will appear for you to 
enter your query. Click Search when ready.  

• Type in a keyword or phrase in the Search for: box  
, located on the right side of the menu bar and 

press Enter.  
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AAAddddddiii ttt iiiooonnnaaalll    RRReeesssooouuurrrccceeesss   
   

If you are interested in learning more about Word, there is a book available for you to check out from 
the Learning Curriculum Resource Library: 
 
Perry, Greg.  Teach Yourself Microsoft Office 2003 in 24 Hours.  Indianapolis, IN: Sams, 2004. 

 
 

 
A complete listing of titles in the Learning Curriculum Resource Library is available at: 

http://www.lib.umd.edu/groups/learning/lcrlibrary.html 
 
You may also wish to consult these online Word guides:  
 
Microsoft Word 2003. University of Wisconsin – Eau Claire. http://www.uwec.edu/help/word03.htm   
 
Getting Started in Microsoft Word 2003. Wellesley College. 
http://www.wellesley.edu/Computing/Office03/Word03/word03.html.   
 
Microsoft Office Training Home Page. http://office.microsoft.com/training  [Select “Word” in “Browse 
Training Courses”.]  
 
 
 
CCCrrreeedddiii tttsss:::    
      
Material in this packet adapted from Stephen Spohn, Jr.’s Microsoft Word 97 for Beginners tutorial.  
Revised and updated by Ambika Sankaran, Staff Learning and Development, October 2004. 
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